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Apple Pro Training Series: Final Cut Pro X 10.1

(updates for software version 10.1.2)

Lesson 1
Page 6 change in paragraph 1

an external volume you’d like to use, ensure that the volume is set up in a supported format
such as HFS+, that you have read and write permissions for the volume, and that the
volume is on a fast storage device such as a 7200 RPM hard disk or solid-state disk with a
minimum 10 GB of available storage space.

Lesson 2

Page 15 replace paragraph after sidebar

Before you decide what to place into your events, remember that an event in Final Cut Pro
is a virtual storage container. You may move and reorganize the clips within events to help
you quickly locate your editing content. What is hidden from view is the powerful media
management that Final Cut Pro performs under the hood as you import and organize files
into those events. Events work in conjunction with the larger library container to define the
virtual and physical locations where your source media files are stored.

Page 15 replace last paragraph after image

In Lesson 9, you'll further explore the media management settings and tools that apply to
clips, events, and libraries. Those tools allow you to move, copy, and organize the source
files within Final Cut Pro. For now, let's start importing clips, and see how Final Cut Pro
handles your media when using the default media management settings.

Page 16 replace 1st paragraph and Add new Stepl

Because all the clips you'll edit are contained inside an event, and an event is contained
inside a library, you'll need to create a library before you can import media. A library can
be saved on any accessible and supported local or network volume.

1 From the Dock or the Applications folder, open Final Cut Pro.
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Renumber existing steps in 2.1.1

Page 17 renumbered Step 5 replace image

L1 ] .
titled
sefntite New Event

® 3-26-1 New Project

Import Media...
Consolidate Library Files...

Sort Events By
Reveal In Finder
N Close Library “Untitled”

Page 18 replace step 3 2nd image

GOPRO1

Page 18 insert after step 4

NOTE: If iPhoto or Aperture are set to open when a camera is connected, press Command-Q
to quit either application if one has opened automatically.

Page 19 replace step 5 image

Final Cut Pro
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Page 20 replace 1st image

GOPRO1

B Macintosh HD

E
A apts
Z Desktop

GOPRO1 Videos

Create Archive. : 4 All

Import All....

Page 21 replace 1st image

(®) Add to existing event: | GoPro +
(") Create new event in: “Lifted” library =
Event name:

Files: (®) Copy to library
() Leave files in place

Transcoding: | Create optimized media
("] Create proxy media
Keywords: [2] From Finder tags
@ From folders
(") Find people
Consolidate find people results
Create Smart Collections after analysis

Video: Remove pulldown
[_] Analyze for balance color

Audio: [_| Analyze and fix audio problems
[_) Separate mono and group stereo audio
) Remove silent channels

[“Cancel |
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Page 22 replace 1st image

AARMEDAC
wANVIENRAOD

GOPRO1 [§

Page 23 replace starting at Step5
5 Navigate to the location of your FCPX Media folder, and click the New Folder button.

6 Enter Lifted Archives as the new folder name. In the New Folder dialog, click Create,
and in the Media Import dialog, also click Create.

New Folder

Name of new folder:

[Lifted Archives| ]

| Cancel | [ Create ]

A timer appears next to the GoPro1 card in the sidebar. You may proceed with the
importing process before the archive has completed.

CAMERAS
wAVIERNAO

GOPRO1

Page 26 replace Step 1 image

~ A ACDAC
VA rn IERAY

GOPRO1 [}

Page 27 replace Step 8 subtext

The playhead moves in reverse at two times the normal speed. You can press J up to six
times, increasing the search rate each time. You can increase forward playback speed by
pressing L.
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Page 27 replace Step 1

1 In the Media Import window, locate the Zoom slider.

Page 27 replace Step 2 image

LES

Page 28 ADD after subtext at top of page

NOTE: When the frames representing a clip extend beyond a line of frames, the edges of the
line appear torn. The clip's filmstrip continues on the next line.

Page 29-30 replace starting at step 1 until 2.4

1 In GOPRO0O03, skim to the start of the thumbnail, and press I to mark the start of the
range.
2 To set the end of the range, skim to a few moments before the helicopter lifts off the

pad, and press O.
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This range covers the helicopter on the pad with rotors turning. Now you will set a second
range within the file.

3 Cue the skimmer or playhead to just before the helicopter lifts off, and then press
Command-Shift-I.

4 While still in GOPR0003, skim to just after the helicopter has exited the frame and
press Command-Shift-O to mark the end point.

Now that you have marked two ranges in GOPR0O003, notice the two ranges are separated
only by a couple of seconds. Rather than create two physical clips, you'll save this clip to be
treated as two virtual clips in Lesson 3.

5 With the two ranges still selected in yellow, press Option-X to clear the two range
selections.

With the ranges cleared, the Import All button returns allowing you to import all six clips
without manually selecting them.

6 Click the Import All button.

Import All...

The Media Import Options dialog appears. Next you will define the media management for
these incoming files.

Page 31 replace last two paragraphs after the 2nd image

This section of the Media Import Options dialog defines which event in the library will
contain the imported clips. This is a virtual storage assignment that allows you to start
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organizing your clips for editing within Final Cut Pro. Let's turn our attention to where the
source media files for those clips will be physically stored.

Page 32-33 replace section
Choosing Physical Storage

To simplify this discussion, just remember two fundamental facts about Final Cut Pro
libraries:

e Libraries are virtual containers for events and the event clips.
e Libraries are physical containers for events and the event clips' source media files.

While that second fact is entirely true, a deeper question remains about the source media
files' storage location. Are the source media files for those clips physically stored inside the
library, or are those event references only pointers to source media files stored in a
different physical location? This is a decision you make when you choose to use either
managed media or external media.

Managed media is the simplest approach to using Final Cut Pro for a single user, a mobile
editor, or for archiving. You instruct Final Cut Pro to physically copy imported media files
inside a selected library. And because you created the library earlier, you've already
defined where on a volume the media will be stored and managed by Final Cut Pro.

Files: (¢) Copy to library
() Leave files in place

Despite the simplicity of managed media, external media is a best practice for media
management, especially in environments where the source media files are shared among
multiple users. With externally referenced media, source files are stored outside the Final
Cut Pro libraries. Doing so allows other editors to access the source media files without
interrupting your workflows. This option also keeps the libraries small, which translates to
faster load times, less memory consumption, and easier sharing when passing a library to
another user media storage access.

Files: ( ) Copy to library
() Leave files in place

When importing source media files from a volume rather than a camera card, the second
media storage option, "Leave files in place,” is available. Also known as "Edit in place," this
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option does exactly what it says. No source media files are copied or moved during import,
which leaves the files as external media outside the library.

Page 33-34 replace 2nd image and respective bullets

Keywords: [2] From Finder tags
@] From folders
| | Find people
Consolidate find people results
Create Smart Collections after analysis

« From Finder tags: Creates and assigns clips to Keyword Collections respective to the
OS X tags assigned to the clips

 From folders: Replicates an existing folder structure at the Finder level within the
event using keywords

 Find people: Analyzes the clip for shot composition and facial detection

e Consolidate find people results: Averages the Find People results based on two-
minute sections of a clip

e Create Smart Collections after analysis: Aggregates the results of the Find People
analysis into a dynamic collection

Page 34 insert new image and bullets before first existing image

Video: Remove pulldown
|_| Analyze for balance color

« Remove pulldown: Applies to source media files recorded in a special frame-cadence
format

e Analyze for balance color: Creates a one-click neutralizing correction averaged
across the clip's duration
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Page 34 replace step 1 image

(®) Add to existing event: | GoPro s
I.;:,,' Create new event in: “Lifted"” library =
Event name:

Files: @ Copy to library
Leave files in place

Transcoding: [ | Create optimized media
[ Create proxy media

Keywords: From Finder tags
From folders
[ Find people
Consolidate find people results
Create Smart Collections after analysis

Video: Remove pulldown
("] Analyze for balance color

Audio: [ | Analyze and fix audio problems
[_| Separate mono and group stereo audio
[ ] Remove silent channels

| Cancel | [ Import |

Page 35 replace starting with subtext of step through step 4

You've instructed the import process to create clips in the GoPro event that represent those
source media files. Now you will see where Final Cut Pro will store the source media.

3For Files, notice that Copy to library is chosen.

Files: @ Copy to library
Leave files in place

These source media files will become managed media files within the Lifted library. The
source media files will be copied from the SD card to the GoPro event stored in the Lifted
library. Because these will be managed media files, your only concern is whether you
placed the library on a volume with enough free space to store all of the managed media.
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4Deselect any other transcode, keyword or video and audio analysis options. Click Import.
Page 35 delete fourth bullet after step 4
Page 36 replace paragraph after bullets

A difference between volume and camera import will be visible in the Browser pane:
Importing from a volume displays files in list view by default.

Page 37 add caption to image

An offline media file appears as above in Final Cut Pro
Page 37 replace first paragraph after image

When you import source media files from a volume, Final Cut Pro gives you the option to
copy or not to copy those source files. You would copy the source media files if they were
stored, for example, on a borrowed volume you had to return before you were finished
editing. Copying is also a preferred choice when you import media from a shared storage
volume to a portable volume to make your project portable.

Page 37 replace sidebar
Using Symlinks

When you're using external media, the source media files are not copied into the library.
Instead, symlinks (simulated clips) are created inside the library that refer to the externally
stored source media files. That external location may be anywhere on any accessible
volume. Using external media files is the best practice for any editor, especially in a
multiuser environment.

Page 38-39 replace starting at step 2 through the image at step 8

2 Starting in the sidebar, navigate to the location of the FCPX Media folder created in
Lesson 1.
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| @ Documents

Name
 FCPX Media

W Lifted Archives

This location is either an external volume, your Documents folder, or your desktop. The
necessary media is in the FCPX Media Import folder. Selecting your home folder in the
sidebar is one possible starting point.

3 Take a look inside the FCPX Media folder for the LV1/LV Import folder. Specifically,
look inside the LV Import folder to display its contents.

| M FCPX Media

Name

LV

M LV Import
i 5D-7D
i Audio
i iPhone

i LV SFX

The media files have been sorted by folder. You can take advantage of this organizational
structure in Final Cut Pro.

4 With the LV Import folder selected, click Import Selected.
The Import Options dialog opens. You will select a few options this time.

5 At the top, select "Create new event in," and from the pop-up menu, choose the
Lifted library. Type Primary Media as the event name.

@Create new event in: | “Lifted” library

Event name: | Primary Media
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Remember, you can set up the event and library to organize your media however you wish.
Unlike the previous import, this time during import you will reference external media that
is left in place. Because you have constant access to the volume where the media files
reside, you do not need to copy the source media.

6 In the Files category, select "Leave files in place."

Files: () Copy to library
() Leave files in place

Another difference from the previous import method is that you will import a folder of
media files. Final Cut Pro can import the metadata of the Finder folder structure using
keywords. Keywords are metadata tokens applied to a clip. Keywords later may be used to
quickly sort and find distinct or related (or unrelated) clips. This feature is very handy
when your library contains a few hundred or a few thousand clips.

NOTE: Creating keywords from OS X tags is covered in Lesson 5.

7 From the Keywords category, select "From folders."

Keywords: [ | From Finder tags
@] From folders
|_| Find people

NOTE: The command applies keywords only when a folder is selected for import.
Importing selected files within the folder will not apply keywords.

8 Deselect all other transcode, and video/audio analysis options, then click Import.

Libraries

=% Lifted

® GoPro
» % Primary Media
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Page 40 replace step 9 subtext after image and note

The folder you selected, and its enclosed folders, were converted into keywords. Choosing
the "From folders" import option copies the Finder folder structure into the event.

NOTE: You will learn more about using keywords, along with other metadata techniques, in
Lesson 3.

Page 40-41 replace steps 1 and 2 and the first image on page 41
1 Choose Final Cut Pro > Preferences.

2 In the Preferences window, click the Import button.

Copy to library storage location
Leave in place

Transcoding: Create optimized media

Create proxy media

Keywords: From Finder tags
¥ From folders

Find people

Video: Analyze for balance color

Audio: Analyze and fix audio problems
Separate mono and group stereo audio

Remove silent channels

Page 41 replace the two bullets

e  When an item is dragged to an event, a Keyword Collection in an event, or the
Browser, and the "Copy to library storage location" option is selected, the pointer
displays a plus sign inside a circle.

® GoPro
¥ * Primary Media
i 5D-7D

[ MVI_0188.
M Audico &

M iPhone
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e  When an item is dragged to an event, Keyword Collection, or the Browser, and the
"Leave in place" option is selected, the pointer displays a hooked arrow.

Page 42 ADD after 2nd bullet

NOTE: Alternatively, media files may be dragged to the Browser for importing into the
selected event or keyword collection.

Page 42-43 replace question 8's images

() Add to existing event: = Primary Media :

(®) Create new event in: | “Lifted"” library

4»

Event name:

Files: () Copy to library
(®) Leave files in place

B
Page 43 replace question 10

10.  When dragging files from the Finder to an event, where do you set the option to
copy (or not copy) the files into the library?

Page 43 replace answer 8

8. B. "Copy to library" creates managed media while "Leave files in place" creates
externally referenced media.

Page 43 replace answer 10
10.  Final Cut Pro > Preferences and select the Import icon.

Page 43 replace answer 11

11. From folders



Print book ISBN: 987-0-321-94956-1, first print run
July 14, 2014: Updates for software version 10.1.2 (released by Apple on June 27, 2014)

Lesson 3

Page 50 replace step 3 image and ADD a second image

O & = =
Group Clips By
Sort By

Content Created
Date Imported

8y = =
Group Clips By
" kSort By Content Created
e ¢ Name
Take
Duration

v Ascending
Descending

Organizes an event's clips by name.

Page 54 replace step 1 image

[ iPhone

[ LV Import,
New Event
New Project
New Folder
New Keyword Collection
New Smart Collection

Import Media...

Sort Events By

Close Library “Lifted”

[}Delete Keyword Collection
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Page 57 replace step 1 image

Keywords for selection

5D-7D B-roll |

Keyword Shortcuts

Interview

Remove All Keywords

Page 60 replace subtext after iPhone table

That takes care of most of the clips in the Lifted library in the Primary Media event. But
remember, you imported GoPro clips into the GoPro event. For these clips, you'll use two
more keywords, which you can either add manually in the Keyword Editor and/or create
keyword shortcuts.

Page 60 DELETE section Batch Renaming of Camera Clips on page 60
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Event: GoPro

Clip Runup Hover Takeoff In Flight Landing
GOPRO0005 X X
GOPR0006 X X X
GOPR0009 X
GOPR1857 X
GOPR3310 X X

Page 63 Replace step 1 image

.. Raoipo ..
) ~
o
d D 0
D, 8 00:00:00:00 00:00 0 00:00 0
Ramp 00:00:00:00 00:00 0 00:00 0
D-7D, B-ro Pre 00:00:00:00 00:00 0 00:00 0
aKeo 00:00 0 00:00 0 00:00 0
D 0 0 0 0 0 0 00:00

Page 64 Replace 1st paragraph

Carefully review the values for the start and end points for the applied keywords. Although
you may see multiple applied keywords at once in the list, you are not necessarily viewing
all the clip's source media.
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Page 64 Replace step 3 image

Name Start End Duration
& DN_9287 00:00:00:00 00:00:17:10 00:00:17:10

o= Ramp 00:00:00:00 00:00:17:10 00:00:17:10
o= 5D-7D, B-roll, Pre-Flight 00:00:00:00 00:00:31:01 00:00:31:01

[§ Interview

[4 iPhone
[ Pre-Flight
4 Ramp
[l Takeoff

Page 64 Replace subtext step 3 after image

The ranges are different. Right now, you are restricted to seeing the range defined by the
Ramp Keyword Collection, which is why the clip's start and end points and the Ramp
keyword's points are the same.

Page 64 Replace step 4 image

Libraries Hide Rejected -
2% Lifted

#® GoPro

® Primary Media
4 5D-7D
A Audio
4 B-roll
[ Flight Controls Name Start End Duration
M Hangar v = DN_9287 00:00:00:00 00:00:31:01 00:00:31:01
[ In Flight o= Ramp 00:00:00:00 00:00:17:10 00:00:17:10
[ Interview o— 5D-7D, B-roll, Pre-Flight 00:00:00:00 00:00:31:01 00:00:31:01

[ iPhone o— Takeoff 00:00:17:20 00:00:31:01 00:00:13:05
Page 65 Replace step 5

5Create two ranges within DN_9463, applying the same two keywords, Ramp and Takeoff,
to the appropriate ranges.

Page 66 Replace step 6 image

Name

= DN_9390




Print book ISBN: 987-0-321-94956-1, first print run
July 14, 2014: Updates for software version 10.1.2 (released by Apple on June 27, 2014)

Page 67 Replace step 7 image

Name Notes Start End

£ DN_9390 Hangar doo... 01:50:41:04 01:50:54:16

& DN 9415 01:58:27:19 01:58:36:14

Page 67 Replace step 8 image
Name
& DN_9390
X
& DN 9415 01:58:27:19 01:58:36:14

Page 72 Replace subtext of step 9 after image

One frame of pause is there. You want to cue the playhead at least one frame before that
"silent" frame to avoid any extraneous audio samples at the end of the silent video frame.
The frames after the playhead are trimmed away.

Page 75 Replace subtext of step 20 after image

Before you apply a note to this favorite and mark the rest of the sound bites, you should
understand some additional facts about ratings.

Page 78 Replace step 3 image

All Clips N
v Hide Rejected A

No Ratings or Keywords
Favorites

Rejected

Unused

Page 79 Replace step 5 image

& GOPR1857 00:00:00;00 00:01:55;20
Favorite 00:00:00;00 00:00:37;21

o= In Flight 00:00:00;00 00:01:55;20
Rejected 00:00:37;21 00:01:55;20
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Page 81 Replace 5D-7D table

Keyword Collection: 5D-7D
Keyword Collection: 5D-7D

Clip Start End Notes Result

MVI_1044  Start of clip opener for me new discovery

MVI_1045 Every time we maybe see or capture crest reveal don't
know capture

MVI_1046 At the end of the day adventure | went on wow look what | saw

MVI_1055 The love of flight uh, so (end of clip) really the passion is

v All Clips
Hide Rejected
No Ratings or Keywords

Favorites
Rejected
Unused

Page 82 ADD sixth bullet
e  Unused: Displays clips that are not used in the open project
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Page 84 Replace 1st image and replace respective bullets adding third bullet

Filter
All

& +/ Used Media [Used

& %Lt Stabilization [Show Excessive Shake =

7 P Keywords Include Any = VIR

¥ 5D-7D ¥ Audio ¥ B-roll
7 Flight Controls 4 Hangar & In Flight
# Interview @ iPhone & Pre-Flight

New Smart Collection

e  Used Media: Displays both used and unused clips in the open project
o  Stabilization: Displays clips that have excessive camera shake
e  Keywords: Displays clips that contain all, any, or none of the selected keywords

Page 84 Replace 1st image and replace respective bullets adding third bullet
1In the Libraries pane, select the Primary Media event.

You are going to use the Filter HUD tools to zero in on those clips you'll need while
editing—specifically, iPhone clips of the flight controls.

Page 86-90 Replace 3.4.1 up to sidebar
Exercise 3.4.1

Filtering an Event

Now that you have a few ratings, keywords, and notes applied to some clips, you are almost
ready to edit. But you're only almost ready because you still need to search, sort, and filter
your clip metadata to find the favored sound bites and B-roll gems among hundreds or
thousands of clips.

1 In the Libraries pane, select the Primary Media event.

You are going to use the Filter HUD tools to zero in on those clips you'll need while
editing—specifically, iPhone clips of the flight controls.

2 In the Browser, from the Filter pop-up menu, choose All Clips.

All Clips 7
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3 In the search field, click the magnifying glass to open the Filter HUD.

I3

4 In the Filter HUD, click the Add Rule (+) button, and choose Keywords while
watching the Browser's contents.

Filter

Text
Includes Y Ratings
Media Type
Type
Used Media
Stabilization
[§ Keywords
People
Format Info
Date

New Smart Collectil Roles

The clips displayed in the Browser do not change, but look at the added rule. The rule may
be interpreted as, "Display all clips containing any of the keywords selected below." Let's
see what happens when you change just one small parameter.

5 In the Filter HUD, change the Keywords pop-up menu to Include All.

Filter
All

& T Text Includes

v L Keywords Include All [} B VI

¥ 5D-7D ¥ Audio ¥ B-roll

¥ Flight Controls @ Hangar & In Flight
¥ Interview ¥ iPhone ¥ Pre-Flight
4 Ramp ¥ Takeoff

New Smart Collection

All the Browser clips disappear because no clip meets the criteria of having all the selected
keywords.

No clips match the current filter setting.

To clear the filter setting, choose All Clips from the Filter
pop-up menu above, and/or click the Reset
button in the search field.
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6 In the Keywords rule, deselect all checkboxes except the Flight Controls and iPhone
keywords.

All

& T Text Includes

@ & Keywords [Tnclude All

5D-7D Audio B-roll

v Flight Controls Hangar In Flight
Interview # iPhone Pre-Flight
Ramp Takeoff

New Smart Collection

Your search returns two clips: The only two clips from an iPhone and showing the flight
controls. You have created a search that filters the contents of two Keyword Collections.
Look back at the lists of metadata types, filters, and rules presented in Reference 3.4. By
using a combination of these items, you can create very complex searches to quickly sift
your event or library, and find the clip you need based on the metadata associated with
those clips. Remembering a clip's name is unnecessary when the metadata identifies a clip
by its content.

Finding Orphaned Clips

With all these great Keyword Collections created, finding the clip you need is simple.
However, a simple problem was created as well: the orphaned clip, which is a clip lost
between Keyword Collections. The clip is still in the event, but does not appear in the more
finely grouped collections because the clip was not assigned a keyword. The Filter pop-up
menu allows you to identify any orphaned clips so you may assign it appropriate keywords
or ratings for later retrieval.

1 If necessary, clear the search field by clicking the X.

N

2 In the Libraries pane, select the Lifted library.

3 From the Filter pop-up menu, choose "No Ratings or Keywords."
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v  All Clips
Hide Rejected
[}No Ratings or Keywords

Favorites
Rejected
Unused

One clip appears in the Browser, GOPR0003. This is one of the GoPro clips you previously
imported. Rather than following the original plan of making two clips from this one, you'll
mark the takeoff portion with a keyword so it is no longer an orphaned clip.

4 Mark a range that includes the takeoff and exiting the frame.

No Ratings or Keywords -

5 Assign the range to the Takeoff Keyword Collection in the GoPro event by dragging
the selected range into the respective event's collection.

A Takeoff :

NOTE: Drag the range to the GoPro event's Takeoff Keyword Collection.

Now you have two clips in the Browser! Because you marked a range within a larger clip,
these two clips represent the leftover media before and after the range you just keyworded.
They are displayed because the filter pop-up menu is still set to "No Ratings or Keywords."
Because you have keyworded the best content from this clip, you may ignore these
remnants by changing the Filter pop-up menu.

6 From the Filter pop-up menu, choose Hide Rejected.
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Page 90 Replace sidebar image

Copy media to the library “Stock Footage”

VI~
g Final Cut Pro will copy all selected items and original media files to
=

the library “Stock Footage”.

Media stored in external folders will be linked to, but not copied.
You can include any available optimized or proxy media.

Include: @Optimized Media
[ Proxy Media

[ cancel | [ ok |

Page 91 Replace step 1 image

® Primary Media ]
| New Event

R 5D-7D New Project

[H Audio New Folder

R B-roll New Keyword Collection
[%New Smart Collection

[ Flight Control

Page 93 Replace step 11 and image

11 Set the Import Options dialog as shown, with all other transcoding, keyword, and
video and audio analysis deselected. Click Import.

(®) Add to existing event: | Primary Media 4l
._: ) Create new event in: “Lifted” library
Event name:

Files: @ Copy to library
() Leave files in place
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Page 94 Replace step 3 image

Notes

i MVI_1042 New Compound Clip... XG
5 MVI 1043 New Multicam Clip...

- Synchronize Clips... X8G
i MVI_1044

i MVI_1045
i MVI_1046

Create Audition

2 MVI_1055 Transcode Media...
‘ [} Analyze and Fix...

Page 95 Replace step 4 image

Analyze and Fix:

Video: [_| Analyze for balance color
@ Find people
[] Consolidate find people results
™ Create Smart Collections after analysis

Audio: | | Analyze and fix audio problems
|
|_| Remove silent channels

| Separate mono and group stereo audio

| Cancel I[ oK ]

Page 96 Replace text after table

These analysis keywords are huge timesavers when a deadline is approaching. When you
need one more B-roll clip that is a single wide shot of the interview subject standing next to
the helicopter in the hangar recorded on the 5D, you can find it thanks to the user, camera,
and Final Cut Pro-applied metadata. That's the sweet spot when editing with Final Cut Pro.
You can think about the story, not the clip.

Page 98 Replace step 2 image

T

= New Audio Role
B New Video Role
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Lesson 4

Page 109 Replace step 6 2nd image

== Lifted Vignette

The project open in the Timeline.

Page 112 Replace step 4 2nd image

Name
B MVI_1042

%+ Medium Shot, One Person
o= 5D-7D, Interview
Favorite passion when kid
& MVI_1055
o= 5D-7D, Interview

#* Medium Shot, One Person

Favorite really the passion is

Page 112 Replace step 5 image

Name
v B MVI_1042
#*# Medium Shot, One Person

o= 5D-7D, Interview

Favorite passion when kid
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Page 113 Replace step 7 image

Name
B MVI_1042

£+ Medium Shot, One Person
o= 5D-7D, Interview

Favorite passion when kid [}

Page 114 Replace step 10 image

B MVI_1042
## Medium Shot, One Person
o= 5D-7D, Interview
Favorite passion when kid
v Used

Page 116 Replace step 2 image after subtext

Page 117 Replace step 5 image

01:31:15:14
01:31:15:14
01:31:15:14
01:31:15:20
01:31:15:20

01:31:25:21
01:31:25:21
01:31:25:21
01:31:18:20
01:31:18:20
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Page 118 Replace step 1 image

== Lifted Vignette

MVI_1042  'MVI_1055

o- Ay “XP -

Page 123 Replace step 1 and image

1In the Browser, switch to filmstrip view, then perform a search for awe.

Page 123 Replace step 2 image
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Page 123 Replace step 4 image

Page 161 Replace step 2 image

4 iPhone
B People
4 Pre-Flight

A Ramp
i Takeoff

Lesson 5

Page 246-247 Replace 5.6.2
Exercise 5.6.2

Importing the Aerial Clips Using Finder Tags

For the Lifted Vignette project, you will create an audition clip to edit all the new aerial
clips into the project as a single clip. You will then cycle through those aerial clips within
the audition clip to find the desired shot.

To prepare for this exercise, you must import the aerial media source files, and organize
them as library clips. These new clips were cataloged and organized using OS X Finder tags
that you will import as keywords for each clip. Let's begin by viewing the tags in the Finder.

1 Hide Final Cut Pro by pressing Control-H

2 In the Dock, click the Finder icon to open a Finder window.
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Finder

3 Navigate to your downloaded FCPX MEDIA > LV2 > LV Aerials folder.
The tags assigned to the aerial clips are hidden by default in list view.

4 If necessary, switch the window to list view, then Control-click the Name column
header and select Tags from the list.

L2
H = FIOEREX R Q
Name
= i Date Modified
v [ LV Aerials Date Created
== Aerials_11_0la.mov Date Last Opened
B2 Aerials_11_02a.mov Date Added
= Aerials_11_03a.mov v Size
& Aerials_11_04a.mov Version
& Aerials_13_01b.mov ¥ Kind
&= Aerials_13_02a.mov Comments

The tags are revealed for each of the aerial clips. While importing these clips, you'll take
advantage of these tags to create keyword collections.

fal LV2 X
A = B EREREEY Q
Name A Size Kind Tags
v [ ] LV Aerials - Folder -
== Aerials_11_0la.mov 228.4 MB QT movie canyon
= Aerials_11_02a.mov 209.1 MB QT movie canyon
= Aerials_11_03a.mov 246.5 MB QT movie canyon, lake
& Aerials_11_04a.mov 213.5 MB QT movie lake, cliff
&= Aerials_13_01b.mov 271.3 MB QT movie desert, lake, cliff
&= Aerials_13_02a.mov 42.3 MB QT movie ake
5 Return to Final Cut Pro by clicking the application's icon in the Dock.

6 Back in Final Cut Pro, click the Media Import button in the toolbar.
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¥

The Media Import window opens. You will use the sidebar to locate the aerial clips for
import.

7 Navigate to your downloaded FCPX MEDIA > LV2 > LV Aerials folder.
8 Select the LV Aerials folder, and click Import Selected.
9 In the Import Options dialog that opens, set the following:

e  Add to the existing Primary Media

e Selectto leave files in place

e  Select "From Finder tags" and "From folders"
e Deselect all other analysis options

(®) Add to existing event: | Primary Media v

() Create new event in: “Lifted” library

Event name:

Files: () Copy to library
(®) Leave files in place

Transcoding: [ | Create optimized media
[] Create proxy media

Keywords: @] From Finder tags
[Q] From folders

10 Click Import.
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All six aerial clips are placed in an LV Aerials Keyword Collection within the Primary Media
event. The six clips are also spread amongst four additional Keyword Collections according
to the tags assigned in the Finder: canyon, cliff, desert, and lake.

Lesson 6

Page 286 replace 1st image
QA AT S EFSFE

Effects
All Video & Audio

b At o

oAl D
50s TV Add Noise

Page 314-318 replace 6.4.1 up to Positioning Images in the Viewer

Exercise 6.4.1

Creating a Two-Up Split Screen

In Lifted Vignette, you made an edit, GOPR3310, that shows Mitch flying the helicopter. He
leans forward to get a better view. Let's composite two images on the screen at once so the
viewer can see what Mitch was looking at.
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Performing a Three-Point Edit for the Split Screen

Although the following technique seems complex for a single edit, after you've learned the
edit you'll be able to perform it without hesitation.

1 In the project, locate GOPR3310.

You're about to connect a B-roll clip, Aerials_11_044a, at the same Timeline point as
GOPR3310, and match its duration. To do so, you will perform a Timeline-based, three-
point edit.

In a Browser-based, three-point edit, you specify a duration in the source clip marked by a
start and end point. In the Timeline, you may simply cue the playhead as the third point.
These are editing steps you've already performed. However, for a Timeline-based, three-
point edit, the edit's duration is marked in the Timeline rather than in the Browser. When
you mark a start or end point in the Browser, a duration is set. When a duration is marked
in the Timeline, its duration overrides the duration set in the Browser (if adequate media is
available).

In this exercise, you will set a duration for the edit based on the duration of GOPR3310, and
then tell Final Cut Pro to use the end point in the source clip for backtime alignment so that
the clip backfills the Timeline duration as a connected clip.

2 Select the GOPR3310 clip, and then press X to mark a range around it.

GOPR3310 DN_9503

I r———

Selecting the Timeline clip alone does not set the duration for the edit. Pressing X sets start
and end points to the duration of the Timeline clip. The visible difference between a
selected and marked clip is the appearance of handles at the end of the marked clip.
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GOPR3310

By -,
=Y s N

)

Fai™~

’

Selected

. |GOPR3310

Marked
3 In the Browser, find Aerials_11_04a.

4 In Aerials_11_04a, cue the playhead or skimmer to around a clip time of 2:30 as the
helicopter is rounding the cliff. Set an end point.

You've now set up the edit. The key command to perform this backtimed edit is Shift-Q—
that is, the connect edit key command, Q, in combination with Shift.

5 Press Shift-Q to perform the backtimed connect edit.
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Aerials 11 04a

£l =] =

GOPR3310

You can't see the result just yet. The aerial clip, layered above the GoPro clip in the project,
is blocking the view. The images from the clips may be repositioned to create a composite.

NOTE: If you received a warning as shown in the following figure, your selection in
Aerials_11_04a was too short. Click Cancel and then adjust the end point of Aerials_11_04a
to the right a few frames.

There is not enough media in the source

% clip to fill the range in the Timeline.
/

The resulting edit will be shorter.

|| Do not warn when shortening edits

. Cancel | [ Continue ]

Page 321 delete subtext step 12; ADD following

In the clip, Mitch leans forward looking for traffic or hazards several times. As the
helicopter starts to come around the cliff would be a critical moment for Mitch to be leaning
forward. You will slip an instance of that action towards the middle of the clip to coincide
with the movement around the cliff.
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13 In the Timeline, activate the Trim tool by pressing T.

14 With the Trim tool placed in the middle of GOPR3310, begin dragging left and then
right.

GOPR3310

N R TN N NN A TN S N e
| ‘." &

15 Continue dragging until you see Mitch sitting back in the chair at the start (left) and
slightly leaning forward before he reaches for the sunshade at the end (right). Release the
mouse button.

NOTE: Look at the mountains in the background of the previous image for additional help
in locating the edit points.

When you release the mouse button, the Timeline clip is already updated with the new
points.

16 Review the edit and repeat step 14 as necessary to align the helicopter's and Mitch's
movements.
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Page 331 replace answer 6, deleting images

6. Reset the parameters by clicking the effect's Reset button (the hooked arrow);
Disable/enable an effect by clicking the effect's checkbox; With the effect's title bar
selected, press the Delete key.

Lesson 7

Page 351 replace step 8

8 In the Timeline, select the audio clip DN_9457, and from the Retime pop-up menu,
choose Custom.

Page 371 ADD after step 9 before last paragraph on page
Adjusting the Volume Level and Keyframes of One or More Clips

As you start to finalize your audio mix, you may find that a role is too loud or that the
overall mix is too soft. You need to change levels, but the techniques you've learned so far
would be tedious to implement if you'd already set keyframes on your clips. A more
efficient method is to use the Adjust Volume Relative command.

1 With the Timeline active, press Command-A to select all the clips.

Currently, your audio mix is centering around -12 dB with peaks to -6 dB. You will use the
Adjust Volume Relative command to raise the whole audio mix by 6 dB.

2 Choose Modify > Adjust Volume > Relative.

The Dashboard changes to the relative adjustment display. Enter the number of decibels to
boost the volume level of the selected clips relative to their current levels. If a clip's level is
keyframed, the keyframes value will increase by that number. To lower the volume level,
enter a negative number (that is, a minus sign followed by the value).

3 Type 6, which then appears in the Dashboard, and press Return.
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The clips' volume levels increase by 6 dB. Most likely, a few spots within the project are
now too loud. You can use the Adjust Volume Relative command to attenuate your entire
mix by 2 dB.

4 If necessary, press Command-A in the active Timeline to select all clips.
5 This time, press Control-L to activate the Dashboard controls for the relative audio
adjustment.

6 Type -2, and press Return.

The volume levels and keyframes of the selected clips decrease by 2 dB. The overall volume
is now at a higher level than when you started this exercise, but you still have a little
headroom to avoid peaking at or above 0 dB.

: Adjust Volume Absolute

The alternative to the relative command is Adjust Volume Absolute, which sets the volume
levels of selected clips to a specified value. Regardless of the volume level value (keyframed
or not), the Volume Absolute command resets the current values, including any volume
level keyframes, to the dB setting you enter in the Dashboard. The Dashboard indicates
when you are making a relative or absolute level adjustment. Control-Option-L is the Adjust
Volume Absolute keyboard shortcut.
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Page 373 Insert as new 7.4 and 7.4.1. Renumber existing 7.4, 7.4.1 and 7.4.2 as 7.5, 7.5.1 and
7.5.2

Reference 7.4

Recording a Voiceover

The Voiceover tool allows you to record audio directly into your project using an external
microphone or a built-in FaceTime mic. One use for this tool is to quickly record a portion
of the voiceover script. When editing the rough drafts, the script may not be locked in.
Rather than paying for the ongoing services of voiceover talent, you may wish to record
yourself for free. This is not intended to secure your 15 seconds of fame. Rather, even a
roughly recorded test soundtrack can help you acquire a better sense of timing and pacing
for your edit. This type of voiceover recording is often referred to as a temp or scratch
track. Although this is a common application for the Voiceover tool, don't be fooled by the
term "scratch.” This tool records high-fidelity audio, and may even be used to record the
actual voiceover for your finished edit. (The audio quality will depend entirely on your
source microphone and recording environment.)

Exercise 7.4.1

Using the Voiceover Tool

For this exercise, you will record a scratch track of yourself adding a tag line to the Lifted
Vignette project. To complete this exercise, your computer must have a built-in
microphone, or you must supply and connect a microphone recognized by OS X.

1 In your Lifted Vignette project, cue the playhead to after the helicopter has passed
overhead in the last shot, the helicopter flying off into the sunset.

DN 9424

2 Choose Window > Record Voiceover.



Print book ISBN: 987-0-321-94956-1, first print run
July 14, 2014: Updates for software version 10.1.2 (released by Apple on June 27, 2014)

Record Voiceover

Input Gain:

Name: Untitled

Advanced

The Record Voiceover HUD appears. Looking at its basic settings, you may choose only to
name the next recording using the Name field, test your mic level using the Input Gain
slider, and then click the Record button to record directly into the Timeline. However, let's
explore the advanced settings.

3 In the Record Voiceover HUD, click the Advanced disclosure triangle.

C)

Input Gain:

Record Voiceover

Name:  Untitled
Advanced
Input: | Built-in Input (1&2)
Output: ' None
Gain:

@ Countdown to record

@ Mute project while recording

¥ Create Audition from takes

Event: | Primary Media

The Advanced settings present additional controls for recording your voiceover, including:

e Input:Choose the source device, and the desired mono or stereo channels. Examples
include the Built-in Input (which is a line-in jack on the computer), FaceTime camera,
or a USB audio input converter.

e Output:Choose the output device such as line-out/headphones or USB audio output
for audio monitoring.
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e  Gain:Adjust the level of the audio input presented to your audio output during audio
monitoring. In other words, set how loudly you hear yourself while recording. The
default —co mutes your voice during recording while allowing you to monitor the
project audio.

e Countdown to record:Display a pre-record timer.

e  Mute project while recording:Disable project audio output during voiceover
recording.

e Create Audition from takes:Compile the project's voiceover recordings into an
audition clip

. Event:Select the destination event for the voiceover's audio files

4 From the Input pop-up menu, choose your available audio source.

@

Input Gain:

Record Voiceover

Name: test1
Advanced

Input: | Shure Digital (1)
None
Output:
Built-in Input | 2
Gain: | v Shure Digital » | v Mono - Channel 1
Mono - Channel 2

#@ Countdown to record
Stereo - Channels 1 & 2

# Mute project while recording

@ Create Audition from takes

Event: | Primary Media

In the example, a Shure X2u XLR to USB converter was used. With any source, verify that
you are choosing the desired input format because many sources give you the option of
selecting mono or stereo. The setting also determines the recorded channel configuration:
Mono In=Mono Clip; Stereo In=Stereo Clip.

5 If you have headphones, choose the Headphones > Stereo - Channels 1 & 2 option.
Leave the Gain at -oo.
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@

Input Gain:

Record Voiceover

Name: test1

Advanced

Input: | Shure Digital (1)

Output: | Headphones (1&2)

None
Gain: |
¥  Headphones > Mono - Channel 1
| Shure Digital > Mono - Channel 2

Mute project while recording | ¢ Stereo - Channels 1 & 2

@ Create Audition from takes

Event: | Primary Media

6 Deselect "Mute project while recording,” while leaving the other two options
selected.
7 Choose Primary Media for Event.

¥ Countdown to record

Mute project while recording

¥ Create Audition from takes

Event: | Primary Media

8 In the Name field, type Vignette Tag, and press Return.
You are now ready to record a tag line for the vignette.

9 In the upper-left of the HUD, click the red Start Recording button.
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Record Voiceover

@

Input Gain:

Name:

Advanced

Input:

Output:

Gain:

™ Mute project while recording

Event:

The Start Recording button

X
\_ 1
|

The countdown appears in the Viewer and beeps in the headphones.

[ S

10 When the countdown ends, say into your microphone, Go to H 5 productions dot com
to view more aerial cinematography samples.

11 Click the square Stop Recording button to end this voiceover take.
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Record Voiceover

®

Input Gain:

Name:

Advanced

Input:

Output:

Gain:

Mute project while recording

Event:

The take appears as an audition clip with the playhead cued to the start of the clip. You
could click Play and review the take, but you want to record a second take.

12 Click Record again, repeat the tag line, and then click Stop.

Now that you have two takes to compare, you may use the features of the audition clip to
select the best one. You can access your takes by clicking the spotlight icon on the clip.

Vignette Tag-5 - 00:00:05:14

Duplicate

& Vignette Tag-5
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Page 378 replace image

Color Adjustment Correction 1

= o
L

Saturation Exposure

Global
Shadows
Midtones

@ Highlights

Presets v

Page 379 replace image step 8

Page 379 replace image step 9

Global
Shadows

Midtones

@ Highlights
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Page 381 replace image

Vectorscope (1

Histogram
v Vectorscope
[}uNaveform

v Vector
Mark3

Vertical Layout

Hide Skin Tone Indicator
Monochrome
Brightness

Lesson 8

Page 390 replace 2nd image

iPhone 4, iPod touch (4th gen.)
iPhone 4s, 5/5c, iPod touch (5th gen.)
iPhone 5s

iPad

iPad 2

iPad (3rd/4th gen.), iPad mini

iPad mini with Retina display

iPad Air

Apple TV (2nd gen.)
Apple TV (3rd gen.)
Mac

PC

V)
V)
v
V)
V)
v
V)
V)
V)
V)
V)
V)

Page 404 ADD fourth bullet point
e To export alibrary XML file: With the library selected, choose File > Export XML.
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Lesson 9

Page 409 replace Objectives

« Differentiate external and internal media

e Import media as referenced and managed

e Move and copy clips within and between libraries
Page 409 replace intro paragraph

Libraries provide a convenient way to manage, store, share, and archive one or more
events and projects. In Lessons 1 through 8, you created a new library and imported files as
referenced external media or as copied internal media into the library's events. This
process of working within libraries occurs every time you start an editing job in Final Cut
Pro. In this lesson, you'll experiment further with media managing a library.

Page 410 replace starting at last sentence of 2nd paragraph

The internal media solution within Final Cut Pro can change these editors' habits in a
positive yet not painful way. Let's look at how Final Cut Pro addresses each approach.

%

A Library with both a media empty (external, left) and a media full (internal, right) event.
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The key to library management in Final Cut Pro is the media management of its contained
events. Because the events inside a library may include both external and internal media,
the choices you make for managing source media files will result in media empty or media
full events/libraries, or something in between.

Page 411 replace starting at first sentence

When a library is media empty, the media files for the contained events are symlinks to the
external media files. The empty library has a small file size compared to its counterpart, the
media full library.

An internal "media full" event.
Page 411 replace 4th sentence of second paragraph after image

Sharing a media empty library file that references only external media enables efficient and
cost-effective collaboration using just one set of source media files on a server.

Page 411 replace 1st sentence of third paragraph after image

The media full internal solution works well for an editor who is working solo and/or
prefers to have Final Cut Pro manage the media.
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Page 411 replace note

NOTE: Technically, the library file is a collection of files known as a bundle. Therefore, you
should modify the contents of the library only within Final Cut Pro, and not change them
directly in the Finder.

Page 411 ADD after note

So far, our discussion here has been about internal vs external media—where in relation to
a library are the source media files stored. There is another aspect to the storage location
which is, how did the files get to that location? You've already heard these terms in earlier
lessons: managed and referenced. As you've experienced media management in Final Cut
Pro X, you could restate the storage methods as managed internal or referenced external.
Managed internal was the media management method used with the GoPro clips. You
instructed Final Cut Pro to copy the source media files into the Lifted library. For the other
imported media files, you told Final Cut Pro to leave the files in place which is known as
referencing the existing media files external to the library.

The Library Properties Inspector, in conjunction with your file handling settings in Media
Import Options, sets the physical destinations for the imported media.
Library Properties

®® External vs Managed
®®  \acintosh HD

Storage Locations Modify Settings

;g In Library Consolidate

% InLibrary

@ Final Cut Backups

B Macintosh HD

80.6mB

The Modify Settings button in the Library Properties Inspector controls the Storage
Location Settings. These settings allow you to specify the library for an internally managed
or an externally managed location for media files.
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77;’, Set storage locations for the library “External vs
g Managed".
L —
Newly imported or generated media, cache files, and library
backups will be stored in the locations you choose.
Existing media and backup files remain in their original locations.
Media: In Library

Cache: Media Server 01

Backups: Final Cut Backups

Cancel OK ]

You can specify internally managed or externally referenced locations for imported media,

generated media (renders, thumbnails, and waveforms) and backup library files.

That's right, the Storage Location Settings allow you to set up an external location for
copied files. Changing the Media pop-up menu to a location other than In Library directs
Final Cut Pro to copy future, imported media files to the specified location. This change to
create externally referenced media is evidenced in the copy selection in the Media Import

Options.

Files: (*) Copy to library storage location: Media Storage
Leave files in place

The following table summarizes the media storage location settings, the Media Import
Options available based on that media storage location setting, and the resulting event and

media status for the imported clips.
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Library Management

Library Properties Inspector + Media Import Options = Event/Media Status

Storage Locations Modity Settings Eiles: @ Copy to Iibrary A "media full" event
with internally

managed media

() Leave files in place

22 I Library

A "media empty"
event with externally

Storage Locations Modify Settings

Files: Copy to library
(®) Leave files in place

referenced media

2% In Library

A "media empty"
event with externally

OIRORLCORICRS SOy Files: (*) Copy to library storage location: Media Storage
Leave files in place

referenced media

B Media Storage

Library Management

Left at its default, the Library Properties Inspector lets the Media Import Options
determine the internally managed or externally referenced state of the media files.
Changing the Media storage location in this inspector allows copied media to become
externally referenced option. Let's see the three management methods in action.

Page 412 rename 9.1.1
Exercise 9.1.1

Importing Existing Files as Externally Referenced

Page 412 replace all body text up to step 1 deleting first note

The ultimate external media import option for the obsessive-compulsive editor is "Leave
files in place" (the opposite import option of "Copy to"). "Leave files in place" references
these existing, external files with no moving or copying of the imported source media files.
Symlinks are created within the receiving event that point to the external files, wherever
those files may be.

"Leave files in place" is the ideal choice when you need to share existing, source media files
in a collaborative environment, such as a high-bandwidth, low-latency network. Even if
such a network is unavailable to you at the moment, you may still practice importing a clip
with this option.

NOTE: Choosing to "Leave files in place" virtually mandates that you organize your source
media files before importing their symlinks into a library because moving, renaming, or
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deleting a source media file may cause the referenced clip to go offline in Final Cut Pro.
When you decide that you will reference external media, then you are directly responsible
for keeping Final Cut Pro abreast of any media management you perform outside of the
application. See "Relinking Offline Clips to Source Media" in this lesson.

Page 412 replace step 2 image

000 Save
Save As: [Extemal vs Managed I |z|
Tags:
Where: | (&] Desktop =)

| Cancel | [ Save |

Page 413 replace step 6's image and subtext

4»

(¢) Add to existing event: | External

>

'._:,'Create new event in: “External vs Managed" library -

Event name:

Choosing the External event here does not determine the external or managed state of a
source media file. To be available for editing, every clip must be in an event. However, the
actual media file does not have to be stored within that event's library. A symlink can stand
in for the clip's source media file within the library. The choice of event within the pop-up
menu defines only where the clip will appear in the Libraries pane. The physical location is
controlled by a combination of settings here in the Files section of the Media Import
window and the Library Properties Inspector. The "Leave files in place" option is literally
an "edit in place" command. It produces no copies, and it does not move media. It just
creates a reference to the existing, source media file and adds it to the chosen event.

Page 414 replace step 7's subtext

The two aerial clips appear in the External event's Browser and appear to be normal clips.
When you look at the clips in filmstrip view, you'll see no indication that these clips are
externally referenced. Let's continue importing internally managed clips, and then compare
their storage locations.
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Page 415+ replace Ex 9.1.2
Exercise 9.1.2

Importing as Internally Managed Clips

For the editor who struggles with media management, handing the media management
duties over to Final Cut Pro may save hours (or days) of frustration. A simple selection in
the Media Import Options window creates managed media within an event. By allowing
Final Cut Pro to take command, your struggles with media management are instantly
diminished.

1 Reopen the Media Import window by pressing Command-I.

2 From the LV Aerials folder, select Aerials_13_01b and Aerials_13_02a, and then click
Import Selected.

L2
Bl LV Aerials
B Aerials 11 _01a.mov
B Aerials 11_02a.mov
B Aerials_11_03a.mov

B Aerials 11_04a.mov
™ Aerials 13 01b.mov
™ Aerials 13 _02a.mov

You want to clearly identify these two clips as internally managed, so you will create a new
event for them in the Import Options window.

3 Select "Create new event in," and from the pop-up menu of all open libraries, choose
the "External vs Managed" library.
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Add to existing event: Externa

4»

‘(E) Create new event in: “External vs Managed” library

Event name: Managed|

4 For the event name, enter Managed.

5 In the Files section, select "Copy to library."

Files: @ Copy to library
() Leave files in place

Choosing this option identifies the incoming clips as internally managed media. This setting
is dependent on the Media Storage setting in the Library Properties inspector.

Now that you have a library of events that contain both managed and external media, let's
see how you can determine the difference between them in the Info inspector.

6 Select the "External vs Managed" library to display all clips in the Browser.
7 In the Browser, select Aerials_11_03a.
8 With the clip selected, look at the lower portion of the Info inspector to find the File

Information section.

File Information

® External

[ Macintosh HD Reveal in Finder

. lia R
Original Proxy Generate Proxy

11
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This section lists the containing event for the selected clip. In this instance, Aerials_11_03a
is stored in the External event. Looking at the next info item, you'll find that the location is
the volume where you placed the FCPX Media folder in Lesson 1. If your FCPX Media folder
is stored on your desktop, for example, Location will display the volume's name because
you imported this clip to "Leave files in place.”

9 In the Browser, select Aerials_13_01b.

File Information

® Managed

;g External vs Managed Reveal in Finder

Original Proxy Generate Proxy

The Info inspector displays the location of this file as the "External vs Managed" library.
This is an internally managed media file because it is stored in the library.

Page 418 replace the first para of the first sidebar
Importing by Dragging from the Finder

You may import source media files directly into an event in the Libraries pane or Browser
by dragging them from the Finder or a supported application. While dragging, the pointer
will indicate whether you are importing the files as external or managed media.

Page 419 replace existing step 2 image
Libraries
® ®
== cxternal vs Managed
» % External

% Managed E}

=™ Lifted
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Page 420 replace existing step 4 image

Libraries

== External vs Managed

» % External
® Managed

=™ Lifted

}

QA

Page 419 renumber existing 9.1.3 as 9.1.4 and ADD following as new 9.1.3

Exercise 9.1.3

Copying as Externally Referenced

This hybrid approach to media management is a combination of the two previously
discussed media storage methods. The source media files you are going to import will be
copied to outside the library (externally referenced). This management method allows you
to easily share the source media files in a collaborative networked environment by copying
the media files from camera cards, or another volume, to the shared location using just one
import step. To begin, you change the Media setting in the Library Properties inspector.

1 In the Libraries pane, select the "External vs Managed" library.

2 In the Library Properties inspector, click the Modify Settings button.

Library Properties

®® External vs Managed
®®  Macintosh HD

Storage Locations Modify Settings

The storage location options window opens.
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'ﬁ’, Set storage locations for the library “External vs

g Managed”.
S

Newly imported or generated media, cache files, and library
backups will be stored in the locations you choose.
Existing media and backup files remain in their original locations.

Media: | In Library =

Cache: | In Library =

Backups: | Final Cut Backups 3

[ Cancel |

Here you may specify the locations for storing imported and transcoded media files either
inside or outside the library. Additionally, you may redirect cache files such as renders,
analysis, thumbnails, and waveforms to a location outside the library bundle. The last
option allows you to set a different location for the library backup files. Keep in mind that
these are backups of the Libraries and Browser panes' contents, and not the source media
files.

3 In the Media pop-up menu, click Choose.

Media: v In Library |

Cache: ST
R

&

Backups: | Final Cut Backups 4
4 In the Finder window, navigate to the Desktop, create a new folder named Externally
Copied, and select the new folder before double-clicking OK.
Media: | Externally Copied =
Cache: | In Library ol
Backups: | Final Cut Backups o
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Storage Locations Modify Settings

B Externally Copied Consolidate

The Library Properties inspector lists the Externally Copied location as the media storage
destination. Now, you will import two additional clips to this external location.

5 Reopen the Media Import window by pressing Command-I.

6 From the LV Aerials folder, select Aerials_11_01a and Aerials_11_02a, and click
Import Selected.

L2
B LV Aerials

™ Aerials 11 _01a.mov
™ Aerials 11 _02a.mov

For this exercise, you want to clearly identify these two clips as externally copied, so you
will create a new event for them in the Import Options window.

7 Select "Create new event in," and from the pop-up menu of all open libraries, choose
the "External vs Managed" library.

(¢) Create new event in: | “External vs Managed" library

Event name: | Hybrid

8 For the event name, enter Hybrid.
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9 In the Files section, select "Copy to library storage location: Externally Copied."

Files: () Copy to library storage location: Externally Copied
Leave files in place

A little more definitive than just "Copy to library," this setting reflects the change you made
earlier in the Library Properties inspector.

10 Click Import.
After the import is completed, take a look at these externally copied media files.

11 In the Dock, click the Finder icon.

12 In the Finder window that opens, in the sidebar, select Desktop.
13 Navigate the folder structure to reveal the two aerials clips inside the Externally
®e0o (=] Desktop
(<> (B m ) (=] (%] (2] (o]
FAVORITES Name A
=L All My Files ﬁ External vs Managed
@ AirDrop v [l Externally Copie.d. _
’ v || Final Cut Original Media
i Applications v [ Hybrid
|| n'-.\n Op = Aerials_11_0la.mov

5] PR &= Aerials_11_02a.mov

Copied folder.

This hybrid file management method created external media files by copying them to the
specified media storage location. If that location were a fast, shared network location,
multiple users could access the media file simultaneously without interfering with one
another's workflow.

14 In the Dock, click the Final Cut Pro icon to return to the application.
Page 422 replace step 3 text and image

3 In the Libraries pane, select the External, Hybrid, and Managed events, and then
choose File > Copy Events to Library > On the Go.
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:: On the Go

® 4-3-14

%*® "
== E£xternal vs Managed

% External
% Hybrid

% Managed

Page 424+ replace starting at step 8 up to note on 424e

8 With the "On the Go" library selected, choose File > Consolidate Library Files.
New >
Open Library >
Close Library "On the Go”
Library Properties ~38)
Import >
Transcode Media...
Relink Files...
Export XML...
Share >

Send to Compressor

Copy to Library
Move to Library

Consolidate Library Files...

Delete Generated Event Files...

A dialog asks if you wish to include optimized and/or proxy media. But, there is something
different about this dialog compared to the similar one earlier.

'ﬁa Consolidate Library Files
\ Original Media will be consolidated into the library
\ “On the Go."
</

You can include available optimized or proxy media.
Media stored in external folders will be copied.

Include: [_] Optimized Media

|| Proxy Media

[ Cancel | [ OK |
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9 Notice the last sentence that states external media will be copied. Click OK.

10 When the background tasks indicator returns to 100%, select at least one clip in
each event of the On the Go library and refer to the clip's Info Inspector's File Information.

File Information

EV

® Managed

L
gg On the Go Reveal in Finder

All the clips are now located in the "On the Go" library ready to edit separate from the office
Mac Pro. You are ready to close the library to remove it from the Libraries pane.

11 Control-click the "On the Go" library and from the shortcut menu, choose Close
Library "On the Go."

By choosing to consolidate the media, your source files are packaged as managed media
within the library. This one Final Cut Pro feature avoids many frustrating hours of hunting
down stray media files to package up a complete project.

Page 425 Archiving sidebar, replace 1st bullet with following

1 With the library's events for archiving selected, choose File > Delete Generated
Event Files.

2 Select all three Delete options and All for Render Files.

3 Do not archive optimized or proxy media if you retained all the original source
media files or their camera archive sources.



Print book ISBN: 987-0-321-94956-1, first print run
July 14, 2014: Updates for software version 10.1.2 (released by Apple on June 27, 2014)

Delete Generated Event Files

Delete generated files to free up hard disk space. You cannot
undo this command.

@ Delete Render Files
() Unused Only
@Al

(M Delete Optimized Media
™ Delete Proxy Media

[ Cancel ]HH

Page 426 Other Lib Features sidebar, replace 1st sentence of 1st bullet with following

e  Automatic backups of the library's metadata are made every 15 minutes (if file is
updated).

Lesson 10

Page 433 replace step 9 1st image

Audio Channels  pppe proRes 4444 XQ

Apple ProRes 4444

Apple ProRes 422 HQ

YUPRY NN Apple ProRes 422
Apple ProRes 422 LT

Uncompressed 10-bit 4:2:2
| Use Automatic Settings | = Cancel |

Audio Sample Rate

Page 435 replace step 1 2nd image

ar

(®) Create new event in: [ “Lifted” library

Event name: ILesson 10 I

Files: (®) Copy to library
() Leave files in place

Transcoding: [_| Create optimized media
[ Create proxy media

Keywords: (| From Finder tags
[2] From folders
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Choose to create collections from folders.

Page 450 replace step 4 image

ar

(s) Create new event in: | “Lifted” library

|
Event name: Ilnterview Multicam| l

Files: () Copy to library

() Leave files in place



